Introducing Hummingbird Neighborhood
Hummingbird Neighborhood, like Windows Network Neighborhood, is
fully embedded within Windows Explorer. As an extension of Windows
Explorer, you can use Hummingbird Neighborhood to access and
manipulate the profiles and folders associated with Hummingbird
applications.
Note:

To access Hummingbird Neighborhood, you can either double-click the Hummingbird
Neighborhood icon on the Windows desktop, or navigate to Hummingbird Neighborhood using
the left pane of Windows Explorer.

Hummingbird Neighborhood Features:
Windows Support—Lets you copy and paste, drag-and-drop, delete,
and open existing profiles. This is especially useful when using
HostExplorer to launch multiple remote host connections. Hummingbird
Neighborhood has the same “look and feel” as Windows Explorer.
Shortcut Support—Lets you create shortcuts to HostExplorer profiles;
remote FTP profiles, files, and directories; or any other item within
Hummingbird Neighborhood.
Hummingbird Neighborhood Tuner—Lets you select the location for
the Hummingbird Neighborhood icon. To make this selection, run
hntune.exe from the product installation directory.
Related Topics
Accessing Hummingbird Applications
Introducing Hummingbird FTP
Setting Hummingbird Neighborhood Options

Accessing Hummingbird Applications
The Hummingbird Neighborhood environment provides you with a central
point of access to a number of Hummingbird applications, as well as the
files/directories associated with these applications.

Hummingbird FTP
Hummingbird FTP, a client implementation of the File Transfer Protocol
(FTP), is fully embedded within Hummingbird Neighborhood. The
Windows Explorer “look and feel” of Hummingbird Neighborhood is
especially useful when using Hummingbird FTP. You can easily drag and
drop files between multiple servers. As well, you can connect to an FTP
server simply by double-clicking an FTP profile.
Note:

For information on Hummingbird FTP, see Introducing Hummingbird FTP.

HostExplorer
The HostExplorer product is also easily accessible using Hummingbird
Neighborhood. HostExplorer is a comprehensive PC-to-host connectivity
product that delivers mainframe data to the desktop without the overhead
of legacy protocols. HostExplorer connects desktop computers to IBM
mainframes and IBM-compatible systems, to IBM midrange systems (the
AS/400 family), and to ASCII character systems using Telnet.
Note:

For information on using HostExplorer, see Understanding HostExplorer Profiles.

In the Hummingbird Neighborhood environment, you can launch remote
host connections, as well as customize your profiles by creating
templates and layouts. You can also access HostExplorer user files by
clicking User Files on the Hummingbird menu.

5250 Data Transfer
This feature lets you transfer structured data between your PC and an
AS/400 host in a familiar FTP-style environment. You define an AS/400
connection by configuring and saving a file transfer profile, which is then
displayed in Hummingbird Neighborhood. These profiles also let you set
options for directories, downloading, and uploading. When you open the
profile, you can browse the remote file system and transfer files to and
from it.
To access 5250 Data Transfer from Hummingbird Neighborhood:
Create profiles by clicking New 5250 Data Transfer Profile in the
Hummingbird Neighborhood window. Launch a connection by doubleclicking a profile.

5250 Data Transfer Wizard
The 5250 Data Transfer Wizard is designed to let you transfer files
between a PC and an AS/400 host. When using the wizard to transfer a
file from the host to your PC, you can specify standard SQL statements
to retrieve host data into the downloaded file. For more information on the
5250 Data Transfer Wizard, see the section “Transferring Files” in the
HostExplorer help.
To launch the 5250 Data Transfer Wizard:
On the Hummingbird menu, click 5250 Data Transfer Wizard.

Quick Script Editor
Quick Script Editor is a graphical development environment in which you
can create and modify both HostExplorer and FTP Quick Scripts. These
scripts are made up of commands that automate repetitive tasks. For
information on how to use Quick Script Editor, see the Quick Script Editor
help.
To launch Quick Script Editor:
Perform one of the following actions:
On the Hummingbird menu, click Quick Script Editor.
Double-click the Quick Scripts icon to access the Quick Script files
that are shipped with the HostExplorer product. Then, double-click a
Quick Script file.

Hummingbird Deployment Wizard
The Deployment Wizard is designed to allow administrators to create a
web-deployable installation of HostExplorer. This gives administrators
more control over managing users' desktops while reducing the amount
of resources required to maintain these desktops. For information on how
to use the Hummingbird Deployment Wizard, see the Hummingbird
Deployment Wizard help.
To launch Hummingbird Deployment Wizard:
On the Hummingbird menu, click Deployment Wizard.

Hummingbird Deployment Packager
Hummingbird Deployment Packager, available with Hummingbird
Deployment Wizard, is an administrative tool with a graphical user
interface that makes it easy to create and edit your own customized
Package Assemblies (.dpa files).
To launch Hummingbird Deployment Packager:
In the Administrative Tools folder in the HostExplorer program group,
click Deployment Packager.

Hummingbird Basic Workbench
Hummingbird Basic Workbench is a graphical tool in which you can use
the BASIC command language to create scripts to automate tasks.
To launch Hummingbird Basic Workbench:
Double-click the Macros icon in the Hummingbird Neighborhood window
to access the macro files (.ebs) that are shipped with the HostExplorer
product. Double-click a macro file to open the Hummingbird Basic
workbench window.

Hummingbird Neighborhood Synchronization Wizard
Hummingbird FTP lets you synchronize files and directories to and from a
remote FTP site and maintain sets of local and remote files that have the
same content.
To launch the Hummingbird Neighborhood Synchronization Wizard:
In Hummingbird Neighborhood, navigate to an FTP file, and then click the
SynchWiz button on the toolbar.

Setting Hummingbird Neighborhood Options
You can select a number of options to determine the performance of
Hummingbird Neighborhood. You can specify these options for both
Hummingbird FTP and HostExplorer.
To set Hummingbird Neighborhood Options:
1. Launch Hummingbird Neighborhood.
2. On the View menu, click Hummingbird Neighborhood Options. Click
one of the following six tabs to select and enter configuration
information:
General Page (Hummingbird Neighborhood Options Dialog Box)—
Lets you select values for display and confirmation choices.
FTP General Page (Hummingbird Neighborhood Options Dialog
Box)—Lets you specify values for viewing files, anonymous FTP
connections, and other general FTP operations.
FTP Transfer Page (Hummingbird Neighborhood Options Dialog
Box)—Lets you specify values for file name conversion and select
the file-transfer mode.
FTP Cache Page (Hummingbird Neighborhood Options Dialog
Box)—Lets you set the maximum size of the local cache and the
length of time that cache items remain on your local PC.
HostExplorer Page (Hummingbird Neighborhood Options Dialog
Box)—Lets you select either the Quick Connect or the Connect
with Host Prompt option.
Sounds Page (Hummingbird Neighborhood Options Dialog Box)—
Lets you specify sound files to be played when certain events are
complete.

Introducing Hummingbird FTP
Hummingbird FTP is a client implementation of the File Transfer Protocol
(FTP). You can use the intuitive and familiar drag-and-drop feature of
Windows Explorer to transfer both text (ASCII) and image (binary) files
between local and network drives and FTP servers. Advanced scripting
with OLE automation makes transferring files to multiple hosts and file
viewing extremely powerful and simple.

Features of Hummingbird FTP
Full Windows Explorer Integration—Fully embedded within Windows
Explorer.
Windows Drag-and-Drop & Copy and Paste—Supports Windows dragand-drop and copy/paste features.
Multiple FTP Server Type Support—Supports Solaris, SunOS, AIX,
Windows NT/2000/XP, AS/400, VMS, VM/CMS, MVS, and VM/VPS.
Directory Caching—Caches directory listings locally. This lets you
browse directories offline and improve overall performance.
File Synchronization—Lets you synchronize files between your PC and
the remote server. This is especially useful for FTP Server or Web
publishing.
Live Editing—Lets you automatically edit files using an associated
application and save the changes back to the server.
Shortcuts—Lets you create shortcuts to remote files and folders on your
desktop for single-click viewing.
Security—Supports the following security systems:
Kerberos, an authentication system that secures the data being
transferred between your PC and the FTP server.
Secure Socket Layer/Transport Layer Security (SSL/TLS) protocol
provides security, authentication, and privacy to FTP communication
over Telnet.
Connectivity Secure Shell, a client implementation of the Secure Shell
protocol (SSH-2). This feature is available only if you have purchased
and installed Connectivity Secure Shell. For more information, see
Connectivity Secure Shell Help.
OLE Automation—Supports advanced scripting and OLE Automation.
Related Topics
Setting Hummingbird Neighborhood Options
GSSAPI Dialog Box

SSL/TLS Configuration Dialog Box

Understanding FTP Profiles
FTP profiles are saved session configurations that contain the settings
necessary to connect to an FTP server. Hummingbird FTP lets you
create, edit, rename, and delete FTP profiles in the same manner as you
would manage files in Windows Explorer.
Related Topics
Creating FTP Profiles
Managing FTP Profiles

Creating FTP Profiles
FTP profiles contain all the settings you need to connect to a server, such
as user name, password, and host type. If you do not enter valid data for
all the profile requirements, FTP prompts you to specify settings before
launching a connection.
To create an FTP profile:
1. In Hummingbird Neighborhood, double-click the New FTP Profile icon
(or click New FTP Profile on the File menu). The FTP Site Properties
dialog box opens.
2. Specify information in the following pages:
General Page (FTP Site Properties Dialog Box)
Advanced Page (FTP Site Properties Dialog Box)
Firewall/Proxy Page (FTP Site Properties Dialog Box)
Other Page (FTP Site Properties Dialog Box)
Note:

The information that you specify in the General page (that is, the host address,
user name, password, initial directory, and account) are general information tags
necessary to create a connection.

3. Click OK. The Save FTP Profile dialog box opens.
4. In the Profile Name box, type a name for the new profile. By default,
this box shows the name that you specified in the Host Address box
on the General page of the FTP Site Properties dialog box.
5. Click Save.
Your new FTP profile appears in Hummingbird Neighborhood.
Related Topics
Understanding FTP Profiles
Managing FTP Profiles

Managing FTP Profiles
You can use Hummingbird FTP to rename, remove, or edit the properties
of existing FTP profiles.
To edit, rename, or delete an FTP profile:
1. In Hummingbird Neighborhood, right-click the FTP profile that you
want to edit, rename, or delete and do one of the following:
To edit the settings of the profile, click Properties and make the
desired changes.
To rename the profile, click Rename and type a new name.
To delete the profile, click Delete.
Related Topics
Creating FTP Profiles
Understanding FTP Profiles

Connecting to an FTP Server
To connect to an FTP server, you must use an FTP profile, which
supplies the connection parameters. For more information on creating a
profile, see Creating FTP Profiles.
To connect to an FTP server:
In Hummingbird Neighborhood, double-click the FTP profile that you want
to use to launch the connection.
Note:

If the profile does not contain a valid IP address, user name, and password, Hummingbird FTP
prompts you to supply the missing information.

Disconnecting from an FTP Server
When you are finished with your FTP session, disconnect from the FTP
server.
To disconnect from an FTP server:
In Hummingbird Neighborhood, do one of the following:
On the File menu, click Disconnect.
On the toolbar, click the Connect/Disconnect button.
Right-click on the FTP profile and select Disconnect from the context
menu.
Related Topics
Creating FTP Profiles
Managing FTP Profiles

Setting the FTP Transfer Mode
Before you begin to transfer files, you can specify one of the following
FTP transfer modes:
ASCII—Transfers the files as ASCII text.
Binary—Transfers the files in pure binary form.
Auto Select—Lets Hummingbird FTP determine which of the above
two modes is the best mode for the selected file. The application
determines this by checking the first 512 characters of the file being
transferred. If any of those characters are non-printable (that is, they
are outside of ASCII 32 to 126), then Hummingbird FTP determines
that the transfer mode for the file is binary. You can configure the Auto
Select behavior by specifying the extension and transfer mode in the
FTP Transfer tab.
Note:

For some systems (including MVS and VMCMS), files transferred using the Auto
Select mode will automatically transfer as ASCII files.

You can set the default transfer mode using the toolbar or the FTP
Transfer tab.
To set the default transfer mode using the toolbar:
On the toolbar, click the ASCII, Binary, or Auto Select button.
To set the default transfer mode using the FTP Transfer tab:
1. On the View menu, click Hummingbird Neighborhood Options. The
Hummingbird Neighborhood Options dialog box opens.
2. Click the FTP Transfer tab.
3. In the File Transfer Mode list, click the desired transfer mode.
4. Click OK.
To override the default transfer mode:
1. In Hummingbird Neighborhood, right-click the desired FTP Profile and
click Properties. The FTP Site Properties dialog box opens with the
specified values for the site.

2. Click the Other tab.
3. Select the desired upload transfer mode for this profile.
4. Select the desired download transfer mode for this profile.
5. Click OK.
Related Topics
Uploading Files to an FTP Server
Downloading Files from an FTP Server
Transferring Files Between Servers
FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)

Tracing an FTP Session
Hummingbird FTP provides a tracing feature that lets you monitor or
debug an FTP server connection. All information about the FTP server
connection is then copied to the trace file.
To trace an FTP session:
1. Do one of the following:
On the toolbar, click the Enable/Disable FTP Tracing button.
Right-click an FTP profile and click Enable Tracing.
2. Establish an FTP server connection.
To select a trace file:
1. On the View menu, click Hummingbird Neighborhood Options. The
Hummingbird Neighborhood Options dialog box opens.
2. Click the FTP General tab.
3. In the Trace File box, enter the directory path and file name of the
trace file you want to use, or browse to it.
4. Click OK.
Related Topics
Connecting to an FTP Server
FTP General Page (Hummingbird Neighborhood Options Dialog Box)

Uploading and Downloading Files
After you have connected to an FTP server, you can upload files from
your PC to the server or download them from the server to your local
machine. You can transfer files using the copy and paste or the drag and
drop method.
Related Topics
Uploading Files to an FTP Server
Specifying Transfer Size
Downloading Files from an FTP Server

Uploading Files to an FTP Server
You can copy files from your PC to a remote server.
To upload files to an FTP server:
1. In Hummingbird Neighborhood, select the FTP profile you want to
use.
2. Establish an FTP connection with the selected FTP server.
3. Make sure that you have set the appropriate FTP transfer mode (that
is, ASCII, binary, or Auto Select).
4. In the Exploring window, copy and paste, or select and drag the file(s)
you want to transfer into the destination directory or desired location
on the remote server.
Note:

To stop the file transfer at any time, click Cancel in the Transfer dialog box. To view
the details of the transfer, click Show Details. To keep this window open, click the
push-pin located in the top left-hand corner.

Related Topics
Connecting to an FTP Server
Specifying Transfer Size

Specifying Transfer Size
To improve the efficiency of the file transfer, you can specify the number
of bytes that Hummingbird FTP transfers at a time.
To specify the number of bytes to transfer at a time:
1. On the Hummingbird menu, click User Files.
2. In the FTP folder, double-click the heshell.ini file.
3. Add the following line to the FTP Settings section:

[FTP Settings]
transferchunk = x
where x is the number of bytes being transferred at one time.
4. Save and close the heshell.ini file.
Related Topics
Connecting to an FTP Server
Setting the FTP Transfer Mode
Uploading Files to an FTP Server

Downloading Files from an FTP Server
You can copy files from a remote server to your PC.
To download a file from an FTP server:
1. In Hummingbird Neighborhood, select the FTP profile you want to
use.
2. Establish an FTP connection with the selected FTP server.
3. Make sure that you have set the appropriate FTP transfer mode (that
is, ASCII, binary, or Auto Select).
4. In the Exploring window, do one of the following:
Right-click the file(s) that you want to transfer and click Download.
Navigate to the local folder location and click Save.
Select and drag the file(s) to the desired local folder location.
5. Click Save to save the file and close the Save As dialog box.
Note:

To stop the file transfer at any time, click Cancel in the Transfer dialog box. To view
the details of the transfer, click Show Details. To keep this window open, click the
push-pin located in the top left-hand corner.

Related Topics
Connecting to an FTP Server
Setting the FTP Transfer Mode
Uploading Files to an FTP Server

Transferring Files Between Servers
Hummingbird FTP supports the direct transfer of files between two
servers, depending on the type of remote server.
To transfer files between two servers:
1. In Hummingbird Neighborhood, select the FTP profiles you want to
use to connect to the remote servers.
2. Establish FTP connections with the selected FTP servers.
3. Make sure that you have set the appropriate FTP transfer mode (that
is, ASCII, binary, or Auto Select).
4. Copy and paste the file(s) you want to transfer from one server into
the other remote server destination.
Note:

To stop the file transfer at any time, click Cancel in the Transfer dialog box. To view
the details of the transfer, click Show Details. To keep this window open, click the
push-pin located in the top left-hand corner.

Related Topics
Connecting to an FTP Server
Setting the FTP Transfer Mode

Viewing Files
Hummingbird FTP provides a View feature that lets you open a remote
file for viewing. When you choose this option, Hummingbird FTP saves
the file in a temporary directory on your PC and launches the associated
application.
To view a file:
1. Establish an FTP connection with the selected FTP server.
2. Make sure that you have set the appropriate FTP transfer mode (that
is, ASCII, binary, or Auto Select).
3. In the Exploring window, right-click the FTP file and click View.
If there is no program associated with the file, Hummingbird FTP uses
Notepad to display the file.
Related Topics
Setting the FTP Transfer Mode

Renaming and Deleting Files
After you have established an FTP connection, you can rename or delete
remote FTP server files.
To rename a file:
1. Establish an FTP connection with the selected FTP server.
2. In the Exploring window, right-click the file you want to rename and
click Rename.
3. In the Rename To box, type the new name of the file.
4. Click OK.
To delete a file:
1. Establish an FTP connection with the selected FTP server.
2. In the Exploring window, right-click the file you want to delete and
click Delete.
3. Click Yes to confirm the file deletion.
Related Topics
Connecting to an FTP Server
Viewing Files

Synchronizing Files
Hummingbird FTP lets you synchronize files and directories to and from a
remote FTP site. This feature lets you maintain sets of local and remote
files that must always have the same content. When changes are made
to the master file, the mirror file is updated automatically. The files and
directories to be synchronized must first be set up as synchronization
items in the Hummingbird Neighborhood Synchronization Wizard.
To create a synchronization item:
1. In the Explorer window, navigate to the appropriate FTP file.
2. Right-click the file and click Synchronize. The Edit Synchronization
Item Properties dialog box opens.
3. Specify information in the dialog box.
4. Click OK. Information about the newly synchronized files and
directories appears in the Hummingbird Neighborhood
Synchronization Wizard dialog box.
The wizard displays information about the newly synchronized files and
directories.
Related Topics
Edit Synchronization Item Properties Dialog Box
Editing and Deleting Synchronization Items

Editing and Deleting Synchronization Items
You can edit and remove the synchronization items that you have
created.
To edit a synchronization item:
1. In Hummingbird Neighborhood, select the FTP profile associated with
the synchronized file(s).
2. On the toolbar, click the SynchWiz button. The Hummingbird
Neighborhood Synchronization Wizard opens.
3. From the Synchronization list, select the item that you want to modify,
and then click Edit. The Edit Synchronization Item Properties dialog
box opens.
4. Modify the information in the dialog box as necessary.
5. Click OK.
Related Topics
Hummingbird Neighborhood Synchronization Wizard
Edit Synchronization Item Properties Dialog Box
Synchronizing Files

Synchronizing Files Using the GUI
Hummingbird FTP lets you synchronize files to and from a remote FTP
site. This makes it easy to maintain sets of files that must always have
the same content. The files to be synchronized must first be set up as a
synchronization item in the Hummingbird Neighborhood Synchronization
Wizard.
To synchronize a file using the GUI:
1. In Hummingbird Neighborhood, select the FTP profile that you want to
use.
2. Establish an FTP connection.
3. On the toolbar, click the SynchWiz button. The Hummingbird
Neighborhood Synchronization Wizard dialog box opens.
4. From the Synchronization list, select the desired file(s).
5. Click Synchronize.
6. Click OK.
Related Topics
Connecting to an FTP Server
Hummingbird Neighborhood Synchronization Wizard
Synchronizing Files
Synchronizing Files Using the Command Line

Synchronizing Files Using the Command Line
You can use the command line to synchronize your files and directories.
This feature lets you schedule synchronization tasks using Windows
Scheduler or any other scheduling software.
To synchronize a file from the command line:
1. On the Windows Start menu, click Run.
2. Type the path to the synchronization application in Hummingbird FTP.
For example:

…\Connectivity\version\HostExplorer\FTP\HNSYNCH
where version is the version number of the product you are
running.
3. Enter the following parameter:
-n Event
where Event is the name of the synchronization event you want
to execute. For example, if you wanted to execute a
synchronization event named “SalesReport” then you would run
the following command:
-n SalesReport
Related Topics
Synchronizing Files Using the GUI
Synchronizing Files

Automating Tasks Using Quick Script Editor
Rather than create FTP scripts (.ebs files) based on the
Hummingbird Basic programming language, you can use the Quick Script
Editor, which provides a graphical environment in which to create and
modify FTP scripts (.qsf files).
Using Quick Script Editor, you can:
transfer files and directory trees
create pop-up messages
print files
change transfer modes
control execution flow of Quick Script commands
To create an FTP Quick Script:
1. In Hummingbird Neighborhood, click Quick Script Editor on the
Hummingbird menu. Quick Script Editor opens.
2. On the File menu of Quick Script Editor, click New. The Quick Script
Type dialog box opens.
3. Select FTP and click OK.
For information on how to work with Quick Scripts, refer to the Quick
Script Editor Help.

Managing Directories for FTP
Hummingbird FTP lets you create, delete, and manage directories.
To create a directory:
1. In Hummingbird Neighborhood, open the appropriate FTP profile.
2. On the File menu, click New Folder.
Tip: You can also click the New Folder button on the toolbar.
3. In the New Folder dialog box, type the new folder name and click OK.
4. Click Yes to confirm the directory creation.
To delete a directory:
1. In Hummingbird Neighborhood, navigate to the FTP directory that you
want to remove.
2. Right-click the directory and click Delete.
3. Click Yes to confirm the deletion.
Related Topics
Adding a Directory to the Send To Menu

Adding a Directory to the Send To Menu
The Send To function in Windows Explorer provides a quick method of
transferring files to designated directories (folders). You can add a
Hummingbird Neighborhood FTP directory folder to the Send To Menu.
To add a folder to the Send To menu:
1. In Hummingbird Neighborhood, navigate to the desired FTP directory.
2. Right-click the folder and click Add To ‘Send To’ Menu.
Note:

To transfer a local file to this folder, right-click the file, point to Send To, and click the
remote folder.

Related Topics
Managing Directories for FTP

Directory Caching
Hummingbird FTP maintains a cache of FTP directories and file names
on your local machine, so you can view the directory listing without
establishing a server connection. Hummingbird FTP automatically
updates the local cache when you make changes on the remote host that
affect the file system. Only pointers to the files, not the contents of the
files, are stored in the local cache.
Note:

By default, when you create a new FTP profile, directory caching is enabled. You can change
the default so that directory caching is automatically disabled. For more information, see
Enabling Directory Caching.

Hummingbird FTP also lets you select how often the cache is cleared.
The Clear setting works regardless of whether you have made changes
to the file system on the remote host. The setting is located on the FTP
Cache tab in the Hummingbird Neighborhood Options dialog box
(accessible when you click Hummingbird Neighborhood Options on the
View menu).
You can clear individual FTP server caches or the entire FTP cache. The
cache is not automatically updated if the remote file system is changed.
Tip: Press F5 to refresh a directory.
Related Topics
Clearing the Entire Cache
Clearing an FTP Server Cache
Enabling Directory Caching

Enabling Directory Caching
By default, each time you create a new FTP profile, directory caching is
enabled. You can change the default, so that directory caching is
automatically disabled when you create a new profile.
To enable directory caching:
1. In Hummingbird Neighborhood, select the FTP profile associated with
the cache that you want to enable.
2. Right-click the profile and click Properties. The FTP Site Properties
dialog box opens.
3. Click the Advanced tab.
4. Select Enable Directory Caching.
5. Click OK.
To disable directory caching by changing the default setting:
1. On the Windows Start menu, click Run.
2. Click Browse.
3. In Files of Type, select All Files. Browse to the ftp directory where
the user files are stored on your machine. To access the User
Files folder, double-click the User Files shortcut in the Hummingbird
Connectivity program group.
4. Open the heshell.ini file.
5. Add the following line to the FTP Settings section:

[FTP Settings]
bydefaultenablecacheforprofile = 0
Related Topics
Advanced Page (FTP Site Properties Dialog Box)

Clearing an FTP Server Cache
Hummingbird FTP automatically updates the cache when you make
changes that affect the file system on the remote host. You can, however,
clear the cache yourself.
To clear an FTP server cache:
In Hummingbird Neighborhood, right-click an FTP profile and click Delete
Cache.
Note:

When you delete an FTP server cache, Hummingbird FTP deletes the server directory that is
stored locally on your machine.

Related Topics
Clearing the Entire Cache

Clearing the Entire Cache
When you clear the entire FTP cache, Hummingbird FTP deletes the
server directories that are stored locally on your machine.
To clear the entire cache:
1. On the View menu, click Hummingbird Neighborhood Options. The
Hummingbird Neighborhood Options dialog box opens.
2. Click the FTP Cache tab.
3. Select Clear Cache and click OK.
Note:

When you clear the entire FTP cache, Hummingbird FTP deletes the server
directories that are stored locally on your machine for all of the FTP profiles.

Related Topics
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
Clearing an FTP Server Cache

OLE Automation
OLE Automation is a Windows facility that permits data exchange
between applications and automates tasks. When an object, such as an
image file, is linked to a compound document, such as a spreadsheet,
the document contains only a reference to the object. Any changes made
to the contents of a linked object are seen in the compound document.
You can access and control Hummingbird FTP through OLE Automation.
You can write OLE Automation clients using a variety of tools, such as
Hummingbird Basic, Visual Basic, C++, and Java. The name of the
automation object is HclFtp.Engine.
Note:

For more information about working with FTP OLE APIs, refer to the section “Customizing FTP
OLE” in the FTP API Help. This help file is available only when you install the HostExplorer
Development Kit, available through the Custom or Complete installation of your Hummingbird
Connectivity product.

Creating an OLE Script
You can code OLE Automation containers to implement all of the features
and functions of FTP in another application that uses OLE features, such
as Hummingbird Basic. You can work with FTP session objects to call
functions, such as connecting to a host, transferring files from host to
host, and so on. You can use any tool that supports OLE Automation
control, such as Visual Basic and Visual C++.
To create an OLE Script:
1. Create the main FTP Engine object. All objects support a dual
interface. This lets you fully use the FTP OLE features. For example:

Dim FtpEngine As Object
Set FtpEngine = CreateObject (“HclFtp.Engine”)
2. Retrieve an FTP Sessions collection. This lets you set such things
as local drives, access permissions, and so on. For example:
Dim FtpSessions As Object
Set FtpSessions = FtpEngine.Sessions
3. Create the FTP session object. For example:
Dim FtpSession1 As Object
Set FtpSession1 = FtpSessions.NewSession
4. Set properties such as server name, user name, user account,
and so on. For example:
FtpSession1.ServerName=”ftp.com”
5. Call session methods such as Connect to Host, User Login, Get,
and so on. For example:

FtpSession1.UserLogin

Transferring 5250 Data
5250 file transfer functionality works in much the same manner as
Hummingbird FTP. It lets you transfer one or more files by dragging and
dropping the files between the remote host and the local file system.
You define a 5250 connection by configuring and saving a data transfer
profile, which is then displayed in Hummingbird Neighborhood. These
profiles also let you set options for directories, downloading, and
uploading. When you open the profile, you can browse the remote file
system and transfer data to and from it.
Note:

You can also perform data transfers to and from 5250 systems using the HostExplorer 5250
Data Transfer Wizard. The wizard does not let you drag and drop files. However, it does let you
perform SQL queries. For more information, see HostExplorer help.

Related Topics
Creating and Managing 5250 Data Transfer Profiles
General Page (5250 Data Transfer Properties Dialog Box)
Advanced Page (5250 Data Transfer Properties Dialog Box)

Creating and Managing 5250 Data Transfer
Profiles
5250 data transfer profiles are displayed in Hummingbird Neighborhood
and contain all the settings required to connect to a remote host, such as
the host name and your login credentials, and settings for the file transfer.
For example, you can enable directory caching, specify a code page, and
configure options for downloading and uploading files.
To create a profile:
1. In the Hummingbird Neighborhood window, click New 5250 Data
Transfer Profile. The 5250 Data Transfer Properties dialog box opens.
2. In the boxes provided on the General page, type the host name or IP
address, and then type your user name and password for that host.
3. On the Advanced page, set the transfer options.
4. Click OK.
The new profile appears in the Hummingbird Neighborhood window. It is
named after the host you specified. To connect to the host, double-click
the profile.
To edit, rename, or delete a profile:
Right-click the profile, and then click the related menu item.
Related Topics
General Page (5250 Data Transfer Properties Dialog Box)
Advanced Page (5250 Data Transfer Properties Dialog Box)
Transferring 5250 Data

Understanding HostExplorer Profiles
In addition to letting you work with FTP profiles that contain settings
necessary to connect to an FTP server, Hummingbird Neighborhood
provides you with full accessibility to HostExplorer session profiles.
Note:

To work with HostExplorer profiles, you must have already installed HostExplorer, available
through the Custom or Complete installation of your Hummingbird Connectivity product.

A HostExplorer session profile is a file that contains the necessary
information (host domain name or IP address and host terminal type)
needed to connect to a host. A session profile also contains default
settings that control session functionality and appearance. You can
access and customize the default settings before or after you connect to
a host.
Related Topics
Creating HostExplorer Profiles
Connecting to a Host

Creating HostExplorer Profiles
Before you can use HostExplorer to connect to a host, you need to create
a HostExplorer session profile.
To create a HostExplorer profile:
1. On the File menu, click New HostExplorer Profile, or double-click the
New HostExplorer Profile icon. The New Profile dialog box opens.
2. In the Profile Name box, type a name for your profile.
Note:

The profile name cannot contain any of the following characters: \ / : * ? " < > |

3. In the Profile Type list, select a connection profile type. You can select
a display session profile (3270, 5250, or VT), a printer session profile
(3270 or 5250), or a profile template (which specifies the type as well
as other parameters for a new session profile).
4. To set session profile options immediately, use the Properties button.
Do one of the following:
Click Properties to open the Session Properties dialog box.
Click the arrow to display a list of shortcuts to folders that are
appropriate for the connection profile type that you want to create.
Click a shortcut to go directly to the folder in the Session Properties
dialog box.
5. If you want to apply a theme to the new profile, select a preconfigured or a custom theme in the Theme box. You can create
custom themes in the Session Profile dialog box.
6. In the Connect By list, select the connection method you want to use.
Note:

The Secure Shell option is available only if you purchased and installed Connectivity
Secure Shell and selected VT Display as your profile type. For more information on
securing a HostExplorer VT session with Secure Shell, see the related topic in the
Connectivity Secure Shell Help.

7. In the Host Name box, type the host domain name or IP address.
8. Click OK.
The new HostExplorer session profile appears in the profile list in

Hummingbird Neighborhood.
Related Topics
General Page (5250 Data Transfer Properties Dialog Box)
Managing HostExplorer Profiles
Connecting to a Host

Using Templates
If an existing HostExplorer session profile contains settings that you
would like to use for profiles that you create later, it is a good idea to save
the profile as a template. Therefore, the settings saved in this template
will determine the properties of new session profiles based on that
template.
The Templates directory is a container for all templates and is, by
default, located at the top level of Hummingbird Neighborhood. Any
HostExplorer session profiles that are in this Templates directory can
serve as templates for new profiles.
To create a template:
1. In Hummingbird Neighborhood, right-click the HostExplorer session
profile that you want to use as a template.
2. Copy the profile, and then paste it in the Templates folder.
The session profile will be available as a template and will be listed in the
Profile Type list of the New Profile dialog box.
To create a session profile based on a template:
1. In Hummingbird Neighborhood, open the folder in which you want to
store your new profile.
2. On the file menu, click New HostExplorer Profile. The New Profile
dialog box opens.
3. In the Profile Type list, select the template file on which you want to
base the new profile.
4. In the Profile Name box, type a name for the new profile.
5. Click OK.
The new session profile has inherited the properties of the specified
template.

Managing HostExplorer Profiles
You can edit, rename, modify, and delete HostExplorer profiles in
Hummingbird Neighborhood.
To move, copy, rename, or delete a session profile or folder:
1. Open the Open Session dialog box from the Start menu or
Hummingbird Neighborhood. Right-click the session profile or folder.
2. Using the context menu, perform one of the following actions on the
selected profile or folder:
To move it, click Cut. To copy it, click Copy.Open the destination
folder and click Paste.
To rename it, click Rename. Type the new name and press Enter.
Note:

A profile name cannot contain any of the following characters: \ / : * ? “ < > |

To delete it, click Delete. Click Yes to confirm the deletion.

Connecting to a Host
After you create a HostExplorer session profile, you can use it to connect
to the server.
Note:

Any session profiles that you create using HostExplorer automatically appear in Hummingbird
Neighborhood.

To connect to a host automatically:
1. In Hummingbird Neighborhood, select the HostExplorer profile you
want to use.
2. Perform one of the following actions:
Double-click the profile.
Right-click the profile and click Quick-Connect.
On the File menu, click Quick-Connect.
When the host logon screen opens, you can log on and start working.
To connect to a different host using the same session profile:
1. In Hummingbird Neighborhood, locate the HostExplorer profile you
want to use.
2. Right-click the profile and click Connect. The Connect dialog box
opens showing the host address that you specified for the session
profile.
3. Specify a different host name.
4. Click OK.
When the host logon screen opens, you can log on and start working.
Related Topics
Creating HostExplorer Profiles
Managing HostExplorer Profiles

Working with Layouts
In HostExplorer, you can save a frequently-used working environment as
a layout so that you can re-use it later. For example, if you often work
with four specific sessions placed at certain positions on the computer
screen, you can save this working environment as a layout. Therefore,
the next time you open this layout, the same four sessions will appear in
the exact positions and size in which you saved them.
Note:

For information on saving layouts, refer to the HostExplorer Help.

Hummingbird Neighborhood lets you work with these HostExplorer
layouts.
To open a layout:
In Hummingbird Neighborhood, select the layout that you want to open,
and click Connect. Hummingbird Neighborhood launches the sessions of
the layout in the same positions and size in which they were saved.
To rename a layout:
1. In Hummingbird Neighborhood, locate the layout that you want to
rename.
2. Right-click the layout, and click Rename. The Rename To dialog box
opens.
3. Modify the name of the layout.
4. Click OK.

General Accessibility
Hummingbird products are accessible to all users. Wherever possible,
our software adheres to Microsoft Windows interface standards and
contains a comprehensive set of accessibility features.
Access Keys All menus have associated access keys (mnemonics) that
let you use the keyboard, rather than a mouse, to navigate the user
interface (UI). These access keys appear as underlined letters in the
names of most UI items. (If this is not the case, press Alt to reveal them.)
To open any menu, press Alt and then press the key that corresponds
with the underlined letter in the menu name. For example, to access the
File menu in any Hummingbird application, press Alt+F.
Once you have opened a menu, you can access an item on the menu by
pressing the underlined letter in the menu item name, or you can use the
arrow keys to navigate the menu list.
Keyboard Shortcuts Some often-used menu options also have shortcut
(accelerator) keys. The shortcut key for an item appears beside it on the
menu.
Directional Arrows Use the directional arrows on the keyboard to
navigate through menu items or to scroll vertically and horizontally. You
can also use the directional arrows to navigate through multiple options.
For example, if you have a series of radio buttons, you can use the arrow
keys to navigate the possible selections.
Tab Key Sequence To navigate through a dialog box, press the Tab key.
Selected items appear with a dotted border. You can also press Shift+Tab
to go back to a previous selection within the dialog box.
Spacebar Press the Spacebar to select or clear check boxes, or to
select buttons in a dialog box.
Esc Press the Esc key to close a dialog box without implementing any
new settings.
Enter Press the Enter key to select the highlighted item or to close a
dialog box and apply the new settings. You can also press the Enter key
to close all About boxes.

ToolTips ToolTips appear for all functional icons. This feature lets users
use Screen Reviewers to make interface information available through
synthesized speech or through a refreshable Braille display.

Microsoft Accessibility Options
Microsoft Windows environments contain accessibility options that let you
change how you interact with the software. These options can add
sound, increase the magnification, and create sticky keys.
To enable/disable Accessibility options:
1. In Control Panel, double-click Accessibility Options.
2. In the Accessibility Options dialog box, select or clear the option
check boxes on the various tabs as required, and click Apply.
3. Click OK.
If you installed the Microsoft Accessibility components for your Windows
system, you can find additional accessibility tools under Accessibility on
the Start menu.

Technical Support
You can contact the Hummingbird Technical Support department Monday
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.
Hummingbird Ltd.
1 Sparks Avenue, Toronto, Ontario, Canada M2H 2W1
Canada and the USA
Technical Support: 1-800-486-0095
General Enquiry: 1-877-FLY-HUMM

International
+1-416-496-2200
+1-416-496-2200

Main: +1-416-496-2200
Fax: +1-416-496-2207
E-mail: support@hummingbird.com
FTP: ftp.hummingbird.com
Web Support: support.hummingbird.com/customer
Web Site: www.hummingbird.com

General Page (Hummingbird Neighborhood
Options Dialog Box)
To access
Use the options on the General page to specify Windows Explorer
parameters.
Show Hummingbird Neighborhood On Desktop—Displays the
Hummingbird Neighborhood icon on the desktop. This option appears
only for machines running on the Windows XP platform.
Full Row Highlighting—Highlights the entire file-row properties. When
cleared, FTP highlights only the file name.
Track Selection—Tracks the location of your mouse and highlights the
corresponding row or file name, depending on what you selected for Full
Row Highlighting.
Single Click Activate—Enables a requirement for a single click when
downloading a file to Hummingbird FTP.
Confirm Before Replacing Files—Prompts you to verify a file
replacement.
Confirm Before Deleting Files—Prompts you to verify a file removal.
Related Topics
FTP General Page (Hummingbird Neighborhood Options Dialog Box)
FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
HostExplorer Page (Hummingbird Neighborhood Options Dialog Box)
Sounds Page (Hummingbird Neighborhood Options Dialog Box)

FTP General Page (Hummingbird Neighborhood
Options Dialog Box)
To access
Use the options on the FTP General page to specify general FTP
options.
Double-click an FTP File to—Specifies the operation FTP performs
when you double-click a file. You can either view or download the file.
Default file Viewer—Specifies the program that FTP uses to launch a
downloaded file. The default program is Notepad. Click the browse button
to select another program.
Trace File—Specifies the name of the file that FTP uses to store
information when tracing an FTP session. Click the browse button to
select another file name or location.
Default Anonymous Password—Specifies the password that FTP uses
when you select Anonymous on the General tab for an FTP profile.
Show Console Window—Displays a small console window below the
file listings.
Always Use Default Viewer—Uses the specified default file viewer
instead of the program in which the document was created.
Treat Untested Links as Directories—When the Automatically Resolve
Links option is not selected, selecting Treat Untested Links As Directories
results in FTP treating all untested links on the remote host as
directories. When the Automatically Resolve Links option is selected,
FTP treats all untested links as files.
Number of Seconds to Wait Before Showing the ‘Cancel Directory
Retrieval’ Dialog—Specifies the number of seconds to wait before the
Cancel Retrieve Directory dialog box opens. Select “0” if you do not want
this dialog box to open.
Related Topics
General Page (Hummingbird Neighborhood Options Dialog Box)

FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
HostExplorer Page (Hummingbird Neighborhood Options Dialog Box)
Sounds Page (Hummingbird Neighborhood Options Dialog Box)

FTP Transfer Page (Hummingbird Neighborhood
Options Dialog Box)
To access
Use the options located on the FTP Transfer page to specify general FTP
Transfer options.
Filename Conversion—Configures FTP to automatically edit file
extensions during file transfers. For example, if you are downloading
HTML files, you can request FTP to convert the remote.html files to
.htm files locally. Set up as many conversions as necessary. To enable
this feature after you have configured it, select Enable Filename
Conversion.
File Types—Specifies transfer types for file types. For example, if you
want to transfer a .txt file, then you would specify an ASCII transfer
type for this file.
Convert Filenames to Lower Case on Remote Hosts—Enables FTP to
automatically convert file names to lowercase letters.
File Transfer Mode—Specifies Binary, ASCII, or Auto Select as the file
transfer mode.
Related Topics
General Page (Hummingbird Neighborhood Options Dialog Box)
FTP General Page (Hummingbird Neighborhood Options Dialog Box)
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
HostExplorer Page (Hummingbird Neighborhood Options Dialog Box)
Sounds Page (Hummingbird Neighborhood Options Dialog Box)

FTP Cache Page (Hummingbird Neighborhood
Options Dialog Box)
To access
Use the options located on the FTP Cache page to specify general cache
options.
Cache Size Limit—Sets the cache size limit. The default value is 5 MB.
Cache Items Should Automatically Expire After—Specifies how often
the cache will be cleared. The default value of “0” means that cache
items never expire.
Clear Cache—Clears the current cache.
Related Topics
General Page (Hummingbird Neighborhood Options Dialog Box)
FTP General Page (Hummingbird Neighborhood Options Dialog Box)
FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)
HostExplorer Page (Hummingbird Neighborhood Options Dialog Box)
Sounds Page (Hummingbird Neighborhood Options Dialog Box)

HostExplorer Page (Hummingbird Neighborhood
Options Dialog Box)
To access
Use the options on the HostExplorer page to specify options specific to
HostExplorer.
Display HostExplorer Profiles in Explorer’s Folder View—Displays
HostExplorer profiles (under the Hummingbird Neighborhood tree) in
Windows Explorer.
Double-click to—Select either Quick Connect or Connect with Host
Prompt. Quick Connect uses the host name in the selected HostExplorer
profile. Connect with Host Prompt lets you specify a different host.
Related Topics
General Page (Hummingbird Neighborhood Options Dialog Box)
FTP General Page (Hummingbird Neighborhood Options Dialog Box)
FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
Sounds Page (Hummingbird Neighborhood Options Dialog Box)

Sounds Page (Hummingbird Neighborhood
Options Dialog Box)
To access
The Sounds page consists of the following options:
Events—Lists the program events that are capable of playing a sound
when they occur.
Sound—Lists the available sounds that you can associate with an event.
Browse—Lets you browse for local sound files.
Play—Plays the specified sound.
Related Topics
General Page (Hummingbird Neighborhood Options Dialog Box)
FTP General Page (Hummingbird Neighborhood Options Dialog Box)
FTP Transfer Page (Hummingbird Neighborhood Options Dialog Box)
FTP Cache Page (Hummingbird Neighborhood Options Dialog Box)
HostExplorer Page (Hummingbird Neighborhood Options Dialog Box)

GSSAPI Dialog Box
To access
This dialog box lets you specify the settings used to encrypt the data
transferred between your PC and the FTP server using Kerberos
security.
Transmit/Receive Unencrypted Commands—Select this check box if
you want the FTP commands to be unencrypted. This option is beneficial
if you want to troubleshoot the messages sent to the FTP server.
Note:

It is recommended that you clear this check box since secondary passwords can be transmitted
unencrypted and the server may reject this command. By default, this option is OFF.

GSSAPI Service Name (e.g. host or ftp)—Specifies the GSSAPI
service name, a short alphanumeric text string, which is used by
Kerberos service-based tickets. For example, the service name “ftp” is
used for file transfer, FTP. The default is “host”.
Protected Buffer Size—Specifies the amount of data that is encrypted.
The default is 16,000 bytes.
Data Channel Protection Level—Specifies the extent to which the
channel between the server and your PC is protected and secure.

Encrypted and Protected with Checksum—Indicates that the
data transferred between your PC and the FTP server will be
encrypted and a checksum will be computed for the Kerberos
message. If different keys were used for encryption and decryption
or if the ciphertext was modified, the checksum will not match the
data. This setting offers the most security and integrity of
transferred data.
No Encryption or Protection—Indicates that the data transferred
between your PC and the server will not be encrypted or protected
with a checksum which proves that the data was not modified.
This option is beneficial if you want authentication but not
encryption. For example, if you are using IPSec, a network
protocol, you might not want to encrypt or protect the data, since

data encryption is already built into IPSec. You might also select
this option for testing purposes.
Protected with Checksum Only—Indicates that the data
transferred between your PC and the server will not be encrypted,
but a checksum will be computed for the Kerberos message. This
checksum is used to prove the integrity of the transferred data.
Kerberos Client—Specifies the Kerberos client you want to use to
encrypt the FTP session.
Import Windows Tickets—Copies your Kerberos tickets from the
Microsoft store into the MIT Kerberos cache. This option is available if
you select Hummingbird Connectivity Kerberos for Kerberos Client.
Note:

If your setup does not use Microsoft credentials, it is recommended that you do not enable this
option. If you are unsure, see your system administrator.

Related Topics
General Page (FTP Site Properties Dialog Box)
Advanced Page (FTP Site Properties Dialog Box)
Firewall/Proxy Page (FTP Site Properties Dialog Box)
Other Page (FTP Site Properties Dialog Box)

SSL/TLS Configuration Dialog Box
To access
This dialog box lets you configure your secure FTP connection.
SSL/TLS Version—Select the version of the SSL/TLS protocol that you
want to use for SSL/TLS connections to the server. The default version is
Version 3. It is recommended that you do not use version 2 unless
advised to do so.
Certificate Verification Errors—Selects the action that Hummingbird
FTP takes during SSL negotiation when the host presents a certificate
that cannot be verified.

Connect (ignore errors)—Lets Hummingbird FTP establish the
SSL connection.
Do not connect—Does not let Hummingbird FTP establish the
SSL connection. With this option, you can exempt two groups of
verification errors by selecting Accept Self-Signed Server
Certificates and/or Accept Unverified Server Certificates.
Prompt for acceptance—Displays a list of certificate verification
failures that includes the tests that the server certificate failed.
With this option, you can choose to proceed with, or cancel, the
connection.
Accept Self-Signed Server Certificates—This option is available only if
you selected the Close Connection if SSL Negotiation Fails check box.
Determines whether HostExplorer accepts certificates that have been
signed by the organizations themselves rather than a CA. By default, this
option is cleared.
Accept Unverified Server Certificates—This option is available only if
you selected the Close Connection if SSL Negotiation Fails check box.
Determines whether HostExplorer accepts from the server only the
certificates that have been verified by a trusted certification authority
(CA). If this option is checked, certain certification errors are ignored such

as the certificate has expired, the certificate is not valid yet, and syntax
errors. By default, this option is cleared.
Cipher Suites—Opens the SSL/TLS Ciphers dialog box corresponding
to the SSL/TLS version that you specified in the Version list. In the dialog
box, you can specify the cipher suites that HostExplorer and the server
will use for data encryption.
Encrypt Data Channel—Lets you encrypt the data (the contents of the
files or directories) being transferred between the FTP client and the
server.
User Certificate Mode—Select from the following list of options:

Prompt for User Certificate—If you select this item, the User
Certificate Selection dialog box opens when you re-connect to the
server using this session. This dialog box lets you select or create
a user certificate for the SSL/TLS connection. This option is ideal
for administrators who want different users working on the same
machine to select their own user certificates.
Select User Certificate—Lets you select a user-specific
certificate that you created or imported in the User Certificates
store. Click Browse to specify a user certificate that you want to
use to connect to the host.
No User Certificate—Lets you connect without using a user
certificate. By default, this option is selected.
Certificates and Keys Manager—Opens the Certificates and Keys
Management Console which you can use to create and manage keys
and certificates.
Related Topics
Introducing Hummingbird FTP

General Page (FTP Site Properties Dialog Box)
To access
The General Properties page lets you enter or modify basic FTP
properties. You must supply valid information for all of the options to
connect to a remote host.
Host Address—Specifies the host name or IP address.

TCP/IP Port—Specifies the server (host) port number. The port
number that automatically displays depends on the security option
you select. The default port 21 corresponds to the following
security options:
connections that are not secured
SSL explicit
Kerberos (GSSAPI)
For SSH connections, the default port is 22. For SSL implicit connections,
it is 990.
Note:

If a port value other than the default is chosen for the corresponding security option, the value is
remembered for the site.

User Name—Specifies your login user name.

Anonymous—Select if you are logging into an anonymous site.
You can specify the password for anonymous connections in the
FTP General Page (Hummingbird Neighborhood Options Dialog
Box).
Password—Specifies your login password.
Account—Specifies your login account, if necessary.
Initial Directory—Specifies a startup directory when you are connected.

Root to this Directory—Enables the initial directory to become
the root directory on the remote host.

Security—Specifies the type of security you want to use, if any. If you
specify a security type, click Configure to access the settings.
Note:

The Secure Shell option is available only if you purchased and installed Connectivity Secure
Shell. For more information on securing an FTP session with Secure Shell, see the topic about
securing FTP file transfers in the Connectivity Secure Shell Help.

Configure—Opens the appropriate dialog box for configuring
settings for the security type you selected in the Security box.
Related Topics
Advanced Page (FTP Site Properties Dialog Box)
Firewall/Proxy Page (FTP Site Properties Dialog Box)
Other Page (FTP Site Properties Dialog Box)
GSSAPI Dialog Box

Advanced Page (FTP Site Properties Dialog Box)
To access
The Advanced page lets you enter or modify advanced FTP settings.
Enable Directory Caching—Enables directory caching.
Automatically Resolve Links—Lets Hummingbird FTP automatically
attempt to resolve links.
Passive Mode—Select one of the following:

Selected and Not Dimmed—Hummingbird FTP operates in
passive mode and sends a PASV command to the host. The host
responds with its IP address and port number, allowing the FTP
engine to launch a connection. Typically, you should select this
option if you are operating behind a firewall.
Selected and Dimmed—Hummingbird FTP operates in passive
mode (if passive mode is supported by the host). This is the
default setting.
Cleared—Hummingbird FTP operates in active mode.
Drop Version Numbers on VMS—Hummingbird FTP removes version
numbers from file names when downloading files from VMS machines to
your PC. When you want to transfer multiple files, only the most recent
version of each file gets transferred.
Update Cache on Connect—Hummingbird FTP refreshes its cache with
updated directory listings each time you connect to the remote FTP host.
Allow Optimized Transfer—Specifies a true server-to-server file
operation when transferring files between local and network drives and
FTP servers. This is the default setting. Clearing this option causes the
FTP to first copy the file onto a PC before completing the transfer.
Network Timeout—Specifies the time that elapses before the network
connection times out.

Keep Alive—Sends dummy commands (pings) to the host at specified
intervals. This prevents the host from causing a timeout for your
connection in the event that your connection is temporarily dormant.
Convert from GMT Date/Time Format—Converts the timestamp from
GMT Date/Time format to local Windows format as Hummingbird FTP
receives files.
Hour Offset—Specifies the number of time-correction hours.
Minute Offset—Specifies the number of time-correction minutes.
Commands To Send On Connect—Lets you type the desired FTP
protocol command that you want sent to the host upon successful
connection. Do not include a command that would require opening a new
data socket, such as DIR or LS.
Auto-Detect Server Type—Enables the FTP Engine to automatically
detect the remote server type. When clearing this option, you can view
and select a server type from the drop-down list box.
Type of FTP Server—Lets you select an FTP server. To view this dropdown list box, clear the Auto-Detect Server Type check box.
Related Topics
General Page (FTP Site Properties Dialog Box)
Firewall/Proxy Page (FTP Site Properties Dialog Box)
GSSAPI Dialog Box
Other Page (FTP Site Properties Dialog Box)

Firewall/Proxy Page (FTP Site Properties Dialog
Box)
To access
The Firewall/Proxy page lets you set the Firewall and Proxy properties.
To connect to a Firewall, you must supply valid information for the
following options.
Firewall Type—Lists the available firewall types.
Firewall Address—Lets you enter the firewall address or IP address.
Port—Lets you enter the port number. The default port number is 21.
User Name—Lets you enter your personal user name.
Password—Lets you enter your personal Firewall password.
Related Topics
General Page (FTP Site Properties Dialog Box)
Advanced Page (FTP Site Properties Dialog Box)
GSSAPI Dialog Box
Other Page (FTP Site Properties Dialog Box)

Other Page (FTP Site Properties Dialog Box)
To access
The Other page lets you enter comments about the selected profile and
set the transfer mode for uploading and downloading files.
Comment—Lets you enter any appropriate comments about the selected
profile.
When Uploading, Use the Following Transfer Mode—Lets you set the
transfer mode for uploading files from the FTP site. The options are
ASCII, Binary, and Auto Select. If set to Use the Default Mode, FTP uses
the transfer mode that is currently selected on the FTP Transfer page of
the Hummingbird Neighborhood Options dialog box. Otherwise, the
selected mode overrides the default setting.
When Downloading, Use the Following Transfer Mode—Lets you set
the transfer mode for downloading files to the FTP site. The options are
ASCII, Binary, and Auto Select. If set to Use the Default Mode, FTP uses
the transfer mode that is currently selected on the FTP Transfer page of
the Hummingbird Neighborhood Options dialog box. Otherwise, the mode
selected here overrides the default setting.
Related Topics
General Page (FTP Site Properties Dialog Box)
Advanced Page (FTP Site Properties Dialog Box)
Firewall/Proxy Page (FTP Site Properties Dialog Box)
GSSAPI Dialog Box

Edit Synchronization Item Properties Dialog Box
To access
You can synchronize files to and from a remote FTP site. You can also
create a master file, which lets you easily maintain sets of remote and
local files. When two files are synchronized, the secondary copy is
automatically synchronized with the master each time.
This dialog box lets you set up a synchronization item and designate the
master file.
Name For This Synchronization Task—Lets you provide a name that
identifies this task.
Profile to Use—Specifies the FTP or 5250 profile to be used when
synchronizing the files. This box is selected by default. To select an FTP
profile, click the browse button at the right side of the box.
Remote Filename / Directory—Specifies the remote file name. This box
is automatically filled in when you click Synchronize in the pop-up menu.
Local Filename / Directory—Specifies the local file name to be
synchronized with the remote file. To select the file, click the browse
button to the right of the box. The full path name must be typed in this
box.
Synchronization Direction—Select one of the following options.
To PC—Sets the file on the remote server as the master file. When
synchronized, the file on your PC changes to always mirror the
remote file.
To Remote Host—Sets the file on your PC as the master file. When
synchronized, the remote file on the server changes to always mirror
the local file.
Not Set—Saves the settings but does not synchronize the files.
Auto—Lets Hummingbird FTP determine which of the above
synchronization directions is the best for the selected file(s).
File Transfer Type—Select one of the following options:

ASCII—Files are transferred as ASCII text.
Binary—Files are transferred in pure binary form.
Auto Select—Lets Hummingbird FTP determine which of the above
two modes is the best mode for the selected file(s).
Related Topics
Hummingbird Neighborhood Synchronization Wizard
Synchronizing Files
Editing and Deleting Synchronization Items

Hummingbird Neighborhood Synchronization
Wizard
To access
You can synchronize files to and from a remote FTP site. You can also
create a master file, which lets Hummingbird FTP maintain sets of remote
and local files. When two files are synchronized, the secondary copy is
automatically synchronized with the master each time.
The Hummingbird Neighborhood Synchronization Wizard lets you create,
edit, and delete synchronization items. Use the Synchronization Wizard
to initiate the synchronization process.
Synchronization List—Lists the synchronization items created in the
Edit Synchronization Item Properties dialog box. The remote file name,
local file name, direction of synchronization, and current status appear for
each item.
New—Opens the Edit Synchronization Item Properties dialog box, where
you can specify information for a new synchronization item.
Edit—Opens the Edit Synchronization Item Properties dialog box, where
you can edit the information for the selected synchronization item.
Delete—Removes a selected item from the Synchronization list.
Synchronize—Initiates the synchronization process for a selected file in
the Synchronization List.
Related Topics
Edit Synchronization Item Properties Dialog Box
Synchronizing Files
Editing and Deleting Synchronization Items

General Page (5250 Data Transfer Properties
Dialog Box)
To access
Host Address—Enter the address of the host to which you want to
connect.
TCP/IP Port—Select the port number to use for the connection.
User Name and Password—Enter your user login name and password.
Related Topics
Transferring 5250 Data
Creating and Managing 5250 Data Transfer Profiles
Advanced Page (5250 Data Transfer Properties Dialog Box)

Advanced Page (5250 Data Transfer Properties
Dialog Box)
To access
Enable Directory Caching—Enables directory caching.
Update Cache On Connect—Refreshes the cache with updated directly
listings each time you connect to the host.
Code Page—Lets you select a host code page to convert data received
from the host from EBCDIC to ASCII (and to translate messages sent to
the host from ASCII to EBCDIC). The default language is US English037.

When Downloading
If PC File Exists—Lets you specify what you want to occur in the event
that the transferred file already exists on your machine.
Default PC File Type—Specifies the type of file you want transferred
data to assume on your machine. You can specify text formats or
Microsoft Excel formats.
Include Column Titles—Includes column heading information in the file.
Add File Extensions—Displays the downloaded files with file
extensions.
When Uploading
If Member Exists— Specifies what you want to occur in the event that
the member already exists on the remote file system.
Strip File Extensions—Displays the uploaded files with file extension on
the Remote file system.
Related Topics
Transferring 5250 Data
Creating and Managing 5250 Data Transfer Profiles
General Page (5250 Data Transfer Properties Dialog Box)

